
Release Notes for the Cisco Unity Plug-in for 
Sametime Connect Release 1.2(x)

Published July 12, 2007

These release notes contain requirements, download, installation and configuration instructions, new and 
changed requirements and support, limitations and restrictions, and open caveats for the Cisco Unity 
plug-in for Sametime Connect Release 1.2(x).

The Cisco Unity plug-in for Sametime Connect Release 1.2(x) allows users to view and play Cisco Unity 
and Cisco Unity Connection voice messages directly from their IBM Lotus Sametime 7.5.1 client 
application. This plug-in is available on the Cisco Unified Communications Plug-ins for IBM Lotus 
Sametime Download page at http://www.cisco.com/cgi-bin/tablebuild.pl/cucplugin. For full access to 
the Software Center website, you must be logged on to Cisco.com as a registered user.

The User Guide for the Cisco Unity Plug-in for Sametime Connect Release 1.2(x) is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_user_guide_list.html.

Note The Cisco Unity plug-in for Sametime Connect Release 1.2(x) is available only in U.S. English; no 
multilingual version of this release is planned.
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  System Requirements
System Requirements
Before installing the Cisco Unity plug-in for Sametime Connect, user workstations should meet the 
following minimum system requirements: 

• Microsoft Windows XP (Service Pack 2 or later) 

• 512 MB RAM minimum 

• 20 MB free disk space 

• IBM Lotus Sametime Connect 7.5.1, with the hotfix “Sametime 7.5.1 jar file to add JNDI LDAP 
provider to JRE”

Compatibility Information
The Cisco Unity plug-in for Sametime Connect has been qualified for the version combinations of 
Cisco Unity and IBM Sametime Connect software listed in Table 1.

Determining the Sametime Connect Version

To Determine the Sametime Connect Version in Use

Step 1 In the Sametime Connect main window, from the Help menu, click About Lotus Sametime.

The Lotus Sametime splash screen displays your product version.

Step 2 Click the splash screen to close it.

Table 1 Supported Version Combinations for the Cisco Unity Plug-in for Sametime Connect 

Release 1.2(x)

Component  Requirement

Voicemail System Cisco Unity 4.2 with Microsoft Exchange 2003

Cisco Unity 4.2 with IBM Lotus Domino

Cisco Unity 5.0 with Microsoft Exchange 2003

Cisco Unity 5.0 with Microsoft Exchange 2007

Cisco Unity 5.0 with IBM Lotus Domino

Cisco Unity Connection 2.0

Client Platform Windows XP (Service pack 2)

IBM Sametime Connect Sametime Connect version 7.5.1 with the hotfix “Sametime 7.5.1 jar 
file to add JNDI LDAP provider to JRE”
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  Installation Information
Installation Information
Subscribers with Sametime Connect version 7.5.1 installed on their workstations must also install the 
“Sametime 7.5.1 jar file to add JNDI LDAP provider to JRE” hotfix from IBM. This hotfix is available 
at http://www-1.ibm.com/support/docview.wss?rs=477&uid=swg21259909, and steps for installing this 
hotfix are provided in the User Guide for the Cisco Unity Plug-in for Sametime Connect Release 1.2(x) 
(available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_user_guide_list.html).

Tip For administrators familiar with the Eclipse development and deployment environment, it is possible to 
create an Eclipse plug-in and feature that uses an install handler to automate the installation of the IBM 
hotfix.

See the following topics for information on extracting and installing the Cisco Unity plug-in for 
Sametime Connect:

• Downloading the Cisco Unity Plug-in for Sametime Connect, page 3

• Installing the Cisco Unity Plug-in for Sametime Connect, page 4

Downloading the Cisco Unity Plug-in for Sametime Connect

To Download the Cisco Unity Plug-in for Sametime Connect

Step 1 On a computer with a high-speed Internet connection, go to the Cisco Unified Communications Plug-ins 
for IBM Lotus Sametime Download page at http://www.cisco.com/cgi-bin/tablebuild.pl/cucplugin and 
navigate to the Cisco Unity plug-in for Sametime Connect. 

Note For full access to the Software Center website, you must be logged on to Cisco.com as a 
registered user.

Step 2 On your system, create a directory to hold the Cisco Unity plug-in for Sametime Connect files.

Step 3 Download the file CiscoUnityVoicemailUpdateSiteFiles_1.2.2.1035.tar.gz to the directory you created 
in Step 2.

Step 4 Extract the files by using the application appropriate for your operating system to the directory you 
created in Step 2.

When extracted, the directory structure looks like this:

- features
com.cisco.sametime.voicemail.config.feature_1.1.2.1002.jar
com.cisco.sametime.voicemail.feature_1.2.2.1035.jar

- plugins
com.cisco.eclipse.javamailplugin_1.1.4.1002.jar
com.cisco.sametime.voicemail_1.2.2.1035.jar
com.cisco.sametime.voicemail.config_1.1.2.1002.jar

- web
site.css
site.xsl

.project
index.html
site.xml
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  Using the Cisco Unity Voicemail Configuration Utility
README.TXT

See the “Installing the Cisco Unity Plug-in for Sametime Connect” section on page 4 for information on 
installing the plug-in on subscriber workstations.

Installing the Cisco Unity Plug-in for Sametime Connect
Once you have extracted the Cisco Unity plug-in for Sametime Connect files, there are two ways to 
install the plug-in on subscriber workstations:

• You set up Sametime Connect to automatically install the Cisco Unity plug-in on subscriber 
workstations by using a push update. See your Sametime Connect documentation for information 
on how to set up a push update of the Cisco Unity plug-in.

While subscribers will not have to install the plug-in software with this method, they will still need 
to configure Sametime Connect with their Cisco Unity user name and password information. For 
information on configuring Sametime Connect to enable a subscriber to access their Cisco Unity 
voice messages, see the User Guide for Cisco Unity Plug-in for Sametime Connect Release 1.2(x).

• Subscribers install the Cisco Unity plug-in for Sametime Connect on their workstations themselves. 
For instructions for how to install and configure the plug-in, see the User Guide for Cisco Unity 
Plug-in for Sametime Connect Release 1.2(x).

The User Guide for Cisco Unity Plug-in for Sametime Connect Release 1.2(x) is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_user_guide_list.html.

Using the Cisco Unity Voicemail Configuration Utility
The Cisco Unity Voicemail Configuration Utility enables you to configure the Cisco Unity plug-in for 
all subscribers in your organization who will use the plug-in. This utility can be used for automatic (for 
example, push installations) and for manual installations of the Cisco Unity plug-in, and to update 
subscriber configuration information after the plug-in has been installed.

For configuration changes to take effect, you can either set up Sametime Connect to automatically update 
subscribers by using a push update, or instruct subscribers to update the plug-in from their Sametime 
Connect client.

For additional information on configuring the directory services fields, see the “Configuring Directory 
Services” section on page 7.

Some of the fields in the utility correspond to what is available for subscribers to configure in the 
Cisco Unity Voicemail Preferences window from Sametime Connect. If you do not want subscribers to 
customize a particular field, select the Read Only check box for that field.

To Use the Cisco Unity Plug-In Utility

Step 1 From a command line, copy .../plugins/com.cisco.sametime.voicemail.config_1.1.2.1002.jar to your 
current directory.

Step 2 From a command line, copy .../features/com.cisco.sametime.voicemail.config.feature_1.1.2.1002.jar 
to your current directory.
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  Using the Cisco Unity Voicemail Configuration Utility
Step 3 From a command line, enter the following command to launch the Cisco Unity Voicemail Configuration 
Utility:

java -jar com.cisco.sametime.voicemail.config_1.1.2.1002.jar

Step 4 From the Cisco Unity Plug-in Configuration Utility window, enter values in the applicable fields. The 
fields are described in Table 2.

Note None of these fields are mandatory but any fields that are left empty will need to be configured 
by the subscriber from Sametime Connect on their client workstations. Fields that are left empty 
will not overwrite the Cisco Unity Voicemail configuration of the subscriber in the Sametime 
Connect client application, but updated fields will change configuration information when the 
configuration feature is installed on the client workstation.

Table 2 Cisco Unity Plug-in Configuration Utility Window Fields

Name Description

Voicemail Folder The name of the voice mail folder in the IMAP store.

Voicemail Server The name or IP address of the voice mail store. Select the Read 
Only check box to prevent subscribers from changing this value.

Voicemail Port The number of the port used to communicate with the voice mail 
store. Select the Read Only check box to prevent subscribers from 
changing this value.

Note Cisco Unity Connection provides a port that enables 
license-free IMAP connections. To use this port, set the 
Voicemail Port value to 7993 and ensure that the “Use 
Secure Connection” check box is selected.

Voicemail Poll Interval Time, in seconds, that each client waits before checking for new 
voice messages.

Voicemail Rewind Interval Time, in seconds, that the voice message will rewind when the 
Rewind button on the Voicemail player is pressed.

Voicemail Skip Forward Interval Time, in seconds, that the voice message will skip forward when 
the Skip Ahead button on the Voicemail player is pressed.

Directory Server The name or IP address of the LDAP server. Select the Read Only 
check box to prevent subscribers from changing this value.

Directory Port The number of the port used to communicate with the LDAP 
server. Select the Read Only check box to prevent subscribers 
from changing this value.

Directory Search Base The base (or root) of the directory service in which to search for 
names. The base can be a country, organization or other type of 
group. Select the Read Only check box to prevent subscribers 
from changing this value.

Directory Search Field The field on which phone number lookups are performed. Select 
the Read Only check box to prevent subscribers from changing 
this value.
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  Using the Cisco Unity Voicemail Configuration Utility
Step 5 From the File menu on the Cisco Unity Voicemail Configuration Utility window, click Save.

The saved files are stored in the current directory, and the numbers in their file name automatically 
increment by 1. For example, when saved, the 
com.cisco.sametime.voicemail.config.feature_1.1.2.1002.jar generates another file named 
com.cisco.sametime.voicemail.config.feature_1.1.2.1003.jar, and the 
com.cisco.sametime.voicemail.config_1.1.2.1002.jar generates another file named 
com.cisco.sametime.voicemail.config_1.1.2.1003.jar.

Step 6 Copy the newly generated files back to the .../plugins and .../features directories as applicable.

Step 7 From the File menu on the Cisco Unity Voicemail Configuration Utility window, click Exit.

Note When you close the Cisco Unity Voicemail Configuration Utility window, you lose any unsaved 
changes.

Step 8 Use a text editor to open the site.xml file located in your Cisco Unity plug-in for Sametime Connect 
directory.

Step 9 Edit the following lines to contain the updated file name. For example, the original site.xml file:

<?xml version="1.0" encoding="UTF-8"?>
<site>
<feature url="features/com.cisco.sametime.voicemail.feature_1.2.2.1034.jar"
id="com.cisco.sametime.voicemail.feature" version="1.2.2.1035"/>
<feature url="features/com.cisco.sametime.voicemail.config.feature_1.1.2.1002.jar"
id="com.cisco.sametime.voicemail.config.feature" version="1.1.2.1002"/>
</site>

will be updated as shown (changes are in bold type):

<?xml version="1.0" encoding="UTF-8"?>
<site>
<feature url="features/com.cisco.sametime.voicemail.feature_1.2.2.1034.jar"
id="com.cisco.sametime.voicemail.feature" version="1.2.2.1035"/>
<feature url="features/com.cisco.sametime.voicemail.config.feature_1.1.2.1003.jar"
id="com.cisco.sametime.voicemail.config.feature" version="1.1.2.1003"/>
</site>

Step 10 Save your changes and close the text editor application.

Step 11 For configuration changes to take effect, you can either set up Sametime Connect to automatically update 
subscribers using a push update, or instruct subscribers to update the plug-in from their Sametime 
Connect client.

Use Encrypted Connection Select when the IMAP store requires an encrypted connection. 
Select the Read Only check box to prevent subscribers from 
changing this value.

Enable Detailed Logging Select to turn on detailed logging.

Table 2 Cisco Unity Plug-in Configuration Utility Window Fields (continued)

Name Description
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  Troubleshooting Information
Note When doing any future updates to the configuration, remember to start with the latest 
configuration. For example, if the current configuration is 1.1.2.1003, you would update the 
1.1.2.1003 jars to create a new 1.1.2.1004 configuration.

Configuring Directory Services
For the Cisco Unity Voicemail plug-in to be able to resolve a caller to a Sametime contact, the LDAP 
server configured for Cisco Unity or Cisco Unity Connection should be the same directory server as the 
one used by the Sametime Connect server.

If this is not possible, then the LDAP directory servers for Cisco Unity or Cisco Unity Connection and 
Sametime Connect must use the same unique user name or user ID to represent the same subscriber in 
each directory. Otherwise, the Cisco Unity Voicemail plug-in will not be able to resolve voicemail 
sender information into Sametime contacts.

For best results, regardless of the above configuration, you may optionally provision or provide 
subscribers with the location of an LDAP directory server that contains this information, including 
matching username and phone number, which can be used as the setting for the Directory fields in the 
Cisco Voicemail Preferences page from the Sametime Connect client application. This directory server 
may be the same as or different from the one used by the Sametime Connect server.

Troubleshooting Information
A status bar at the bottom of the Cisco Unity Voicemail application panel indicates when the subscriber 
is successfully connected to Cisco Unity or to Cisco Unity Connection. Any error messages appear as 
hypertext links that the subscriber can click to open a window that provides additional details about the 
error and how to resolve the issue.

If any unexpected or irresolvable issues occur, detailed logging information is available that can assist 
in troubleshooting the issue. See the following “Using Logging to Troubleshoot Issues” section for more 
information on setting up and using log files.

Using Logging to Troubleshoot Issues
When troubleshooting issues with the Cisco Unity plug-in for Sametime Connect, look in the following 
log file directories for errors and warnings:

• C:\Documents and Settings\<username>\IBM\RCP\Sametime\, where <username> is the windows 
user name of the subscriber. The most recent log file is named sametime.log.0.

• C:\Documents and Settings\<username>\IBM\RCP\Sametime\.metadata\.log, where <username> is 
the windows user name of the subscriber.

To Enable Detailed Logging

Step 1 From Sametime Connect, click File > Preferences.

Step 2 From the Preferences window, click the Cisco Unity Voicemail option.
7
Release Notes for the Cisco Unity Plug-in for Sametime Connect Release 1.2(x)

OL-14156-01



  Limitations and Restrictions
Step 3 Click the Enable Detailed Logging option so that it is selected.

Step 4 Click OK to accept these settings and close the Preferences window.

Subscriber Unable to Play Voicemail Due to Port Conflicts
If a subscriber is unable to play a voicemail and receives an “Error attempting to play voicemail” error 
message, check the Sametime.log.0 file. If the log file shows a bind exception, then the Voicemail Port 
may be in use by another plug-in. 

To resolve this problem, change the Voice Chat Port number from the Sametime Administration Console 
on the Sametime Server. For steps on how to change this port, see your Sametime Administrator Guide.

Limitations and Restrictions

MWI On Phone Does Not Change to Reflect Message State
For environments with Cisco Unity 5.0 and Cisco Unity 4.2 with IBM Lotus Domino as the message 
server, the Message Waiting Indicator (MWI) on the phone does not change to reflect the state of a 
message changed from Sametime Connect. For example, the new message light on the phone will not 
turn off after the message is played from Sametime Connect.

SSL Is Not Supported With Microsoft Exchange 2003
Secure Sockets Layer (SSL) is not supported for environments with Cisco Unity 5.0 and Cisco Unity 4.2 
with Microsoft Exchange 2003 as the message server. In these environments, secure user logon is 
provided by using an internal encryption-based authentication module. When NT Lan Manager (NTLM) 
is enabled on the Exchange server, this module utilizes the NTLM protocol to provide a secure login that 
ensures that credentials are not sent as clear text, even with unencrypted connections. The Cisco Unity 
plug-in will first attempt to use the NTLMv2 protocol first, and in the event of failure, will fallback to 
the NTLMv1 protocol.

Caveats
You can find the latest caveat information for the Cisco Unity plug-in for Sametime Connect—in 
addition to caveats of any severity for any release—by using Bug Toolkit, an online tool available for 
customers to query defects according to their own needs. Bug Toolkit is available at 
http://www.cisco.com/pcgi-bin/Support/Bugtool/launch_bugtool.pl.

Note To access Bug Toolkit, you must be logged on to Cisco.com as a registered user.

This section contains caveat information for the Cisco Unity plug-in for Sametime Connect 
Release 1.2(x) only. 
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  Obtaining Documentation, Obtaining Support, and Security Guidelines
Open Caveats—Release 1.2(x)
Click a link in the Caveat Number column to view the latest information on the caveat in Bug Toolkit. 
(Caveats are listed in order by caveat number.)

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.

© 2007 Cisco Systems, Inc. All rights reserved.

Table 3 Cisco Unity Plug-in for Sametime Connect Release 1.2(x) Open Caveats

Caveat Number Severity Component Description

CSCsi61051 3 voicemail Firebaugh/jclDesktop/SSL/Unity/Exchange2003 does not work

CSCsi75424 3 voicemail Forwarded messages do not contain introduction message

CSCsi80650 3 voicemail Unity/Domino: deskphone MWI not in sync with changes made in FB

CSCsj22807 3 voicemail Signed Jar Files Generate Warning in Installation

CSCsj51224 3 voicemail Connection 2.0 CO-RES FB deleted msg didn’t get purged when hardphone 
did

CSCsj51225 3 voicemail Incorrect SSL setting causes failed connection and no error message

CSCsj55622 3 voicemail Unity Connection: Forwarded messages do not show up in FB

CCVP, the Cisco logo, and the Cisco Square Bridge logo are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn is a
service mark of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX, Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco
Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity,
Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet Quotient, IOS,
iPhone, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, iQuick Study, LightStream, Linksys, MeetingPlace, MGX, Networking Academy,
Network Registrar, Packet, PIX, ProConnect, ScriptShare, SMARTnet, StackWise, The Fastest Way to Increase Your Internet Quotient, and TransPath are
registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries. 

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a
partnership relationship between Cisco and any other company. (0705R)
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  Obtaining Documentation, Obtaining Support, and Security Guidelines
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